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Abstract

Around 5% of the Indian population has difficulty in speaking or cannot speak.So,

sign language is a method of non-verbal communication that is used by deaf and

dumb people.

Normal people do not learn sign language. The problem arises here and this

problem becomes a barrier between them. The past implementation of this project

involved using image processing concept and accelerometer.

But the drawback of these implementations are projects were non portable and too

expensive.

In this research paper, we have suggested a wearable glove for people who face

difficulty in communicating verbally due to various different reasons (be it deaf or

dumb), so that with the possession of this device, they can exhibit their basic

requirements via their gestures and those gestures will be converted to speech for

the hearer to understand what is he or she trying to say.

This project Gesture to Voice Converter using Arduino is the better way of

representing hand movement data to the normal people. It is the manual

communication used by mute people for an effective communication. There are

only few who can understand the sign language communicated by the mute

community. The model is developed with the help of electronic device in a way

that translates the sign language into text and speech in order to communicate in

public place. A wired glove is used with flex sensors stitched according to the

length of each finger. This paper guides to the developing technology such as

digital glove. It investigates the qualities of the gadget and examines future wok.

The goal of this paper is to provide innovative framework for this technology.
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Chapter 1

Introduction
A hard of hearing and unable to speak individual uses gesture based

communication for correspondence. Here a glove based gadget acts as a

correspondence for trading of data between normal and mute community.

Communication via gestures is the dialect utilized by hard of hearing and quiet

individuals. The gadget utilises the gestures and converts it into text and voice

which is read and understood by the normal people. A motion in a gesture based

communication is a specific development of the hands with a particular shape

made out of them. A gesture based communication as a rule gives sign to entire

words. It can likewise give sign to letters to perform words that don't have relating

sign in that communication through signing. In this gadget Flex Sensor assumes

the real part, it will sense the change in resistance made on twisting of the sensor.

This advanced glove means to bring down this obstruction faced by the mute

people. It is electronic gadget that can make an interpretation of Sign dialect into

discourse so as to influence the correspondence to occur between the quiet groups

with the overall population conceivable.

It can likewise give sign to letters to perform words that don't have comparing Sign

in that communication via gestures. Sensor gloves innovation has been used by the

mute people, which requests precise following and understanding of gesture based

communication.

The paper clarifies the outlining necessities, elements of digitalised gloves. The

paper clarifies the outlining necessities, elements of digitalised gloves. This paper

guides to build up a couple of signal vocalize gloves. It gives the related work,

clarifies the framework design, qualities, favourable circumstances and

weaknesses of this gadget. In future the framework would be upgraded to wireless

gloves which would be more reliable.
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 RELATEDWORK.

2.1 Microcontroller based Hand Gesture Recognition System using Flex Sensor

for Disabled People The signal acknowledgment is finished with the assistance of

a sensor glove which comprises of five flex sensors, accelerometer sensor that is

best situated in fingers. The plan of glove and the idea of interpreting motion are

made conceivable by considering the pivot introduction of the Accelerometer

sensor concerning gravity and create some voltage esteems. In view of thevoltage

esteems the comparing words will be created from the stored templates. [1].

2.2 Hand Gesture Recognition Application for Physically Disabled People D.

Vishnu Vardhan Vision based hand motion Recognition framework perceiveshand

signal in midair, particularly for physically hindered individuals, and gives

perceived character or number as content and comparing sound. Here the hand

motions will be caught in type of pictures by the camera. From the caught picture,

by advanced picture preparing strategy for each motion developments relating

importance of activities will be perceived and shownas the type of content or by

voice utilizing amplifier [2].
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PROPOSEDWORK.

In this project the sign language translator starts with the Glove, which is the

heart of the project. Fig 1 shows the block diagram of the model. The glove

contains five flex resistors. Their resistance varies with the change in the direction

of fingers. The digital output is fed to the on-chip ADC of the Arduino, thus

converting the analog voltages into digital values. The Sign Language is a hand

gesture used for manual communication. This type of communication is only

understood by few and to make it convenient to the normal people the proposed

model works fine. The Look up table is created for the Alphabetical letters which

is a simple mapping technique. Here the variable is created that stores ADC values

which is compared with the Look up table code. On performing the gesture the

resultant equivalent gesture is converted into the voice which would help the

normal people to understand the sign language.
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Power supply.

Arduino UNO

ATmega-328

4
Flex

Sensors Bluetooth
module HC-05

Smart phone.
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Chapter 2

Litrature Reviews:

1. SachinBhat,AmrutheshM,Ashik, ChidanandDas and Sujith:

In their paper, "Translating Indian Sign Language to text and voice

messages using flex sensors", in International Journal of Advanced Research

in Computer and Communication Engineering Vol. 4, Issue 5, May 2015

have designed a Gesture to voice conversion and have concluded that The

more reliable, user independent and portable system to convert the sign

language to text message form which consumes less power because of the

low ultra power AT89S52 microcontroller is designed

2.Priyanka R. Potdar, DR D.M. Yadav:

“Innovative Approach for Gesture to Voice Conversion: Review.”

International journal of innovative research and development .vol 3,Issue 6,

june2014.have designed Gesture to Voice Conversion and have concluded

that completion of the project suggests that these wiredgloves can be used

for partial sign language recognition. In future work of this proposed system

supporting more number of signs and different language mode.
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3.Mr Prashant chaudhari, prof.G.RPhulay andMrRavindraPatil

In their paper, "A Review on Hand Gesture Recognition System", in

International Journal of Advanced Research in Computer and

Communication Engineering Vol. 2, Issue 3, January 2013 have designed

a Hand Gesture Recognition System and have concluded that data glove

can give promising results if used in the field of medicine and also be

used for monitoring hand function for rehabilitation purpose.

4.Mr.M.V.N.R.P.Kumar, Mr Ashutosh Kumar, Mr. S.B. Arawandekar

Mr. A. A Bhosale, Mr. R.L. Bhosale

“AVR Based Gesture Vocalizer Using Speech Synthesizer IC”.

International journal of Research in Advent Technology, vol 3, issue 5,

May 2015 have designed Gesture to voice recoginisation project and

have concluded that The project aims to lower the communication gap

between the deaf or mute community and the normal world. This project

was meant to be a prototype to check the feasibility of recognizing sign

language using sensor gloves. With this project the deaf or mute people

can use he gloves to perform sign language and it will be converted in to

speech so that normal people can easily understand.
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Chapter 3

TECHNICAL DETAILS.

Methodology.

The user wears a glove that has flex sensors on it. Now when the user wants to say

something, he/she makes gestures by bending the fingers. So, different

combinations are made with the bending of the flex sensors creating different

resistance combinations for the output pin of the Arduino to exhibit different entity.

Arduino is connected to Bluetooth module HC - 05; which is further connected to

Bluetooth speaker/mobile phone. The flex sensor will give input to Arduino with

the bending of the fingers of the person resulting in the change of the angles of the

flex sensor hence changing the resistance will trigger the Arduino to give the

relevant output as per the code we have written i.e. which combination of

resistances will give which entity as my output. Further, when I will have the

output, the speaker which is connected to the Bluetooth module will give the

speech signal as my output.

This Project Includes the following components:-

(i)Flex Sensors

(ii)Arduino Uno (ATmega328p)

(iii)Bluetooth Module (HC-05)

(iv)Android mobile (to use as an output speaker)
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(i)Flex Sensors:

A flex sensor is one of a kind of a variable resistor. It measures the

amount of deflection or bend. It’s a sensor whose output changes when it is

bent i.e. as the sensor is flexed, the resistance across the sensor increases and

when it come back to the normal position i.e it is straight, it has lesser

resistance as compared to the resistance value when it was bent. This change

in resistance is one of the key features being used in our project. The flex

sensor has two output wires and the resistance between these two wires

varies when the sensor is bent. There are four flex sensors used in this

project.

Electrical Specifications:

1. Flat Resistance: 25K Ohms

2. Resistance Tolerance: +-30%

3. Bend Resistance Range: 45K - 125K Ohms (Depending upon bend

radius)

4. Power Rating: Continuously 0.50 Watts and 1 Watt Peak.

Working:

Flex sensor are sensors that change in resistance depending on the

amount of bend on the sensor. They convert the change in bend to electrical

resistance the more bend the more the resistance value. They are usually in

the form of a thin strip from 1”-5” long that vary in resistance. They can be

made uni-directional and bi-directional.
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Fig.3(a): Flex sensor.

(ii)Arduino UNO :

We are using Arduino UNO for designing our glove which is a

microcontroller board based on the ATmega328P. Arduino is a open source

platform that can be used to design various electronic projects. Arduino uno is

hardware which is based on microcontroller ATmega 328P. It has 14 digital

input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16

MHz quartz crystal, a USB connection, a power jack, an ICSP header and a reset

button. Arduino uses its own IDE (Integrated Devlopment Environment) uses a

simplified version of C++, making it easier to learn to program.
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Features

1. Total Power Output: 3W

2. Impedance Satellite: 4 Ohms

3. Signal to Noise Ratio: 76dB

4. Range: 10m

Fig.3(b) Arduino UNO.
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Pin diagram:
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Pin Description

Pin
Category

Pin Name Details

Power Vin, 3.3V, 5V, GND Vin: Input voltage to Arduino when using an external power source.
5V: Regulated power supply used to power microcontroller and other
components on the board.
3.3V: 3.3V supply generated by on-board voltage regulator. Maximum
current draw is 50mA.
GND: ground pins.

Reset Reset Resets the microcontroller.

Analog Pins A0 – A5 Used to provide analog input in the range of 0-5V

Input/Output
Pins

Digital Pins 0 – 13 Can be used as input or output pins.

Serial 0(Rx), 1(Tx) Used to receive and transmit TTL serial data.

External
Interrupts

2, 3 To trigger an interrupt.

PWM 3, 5, 6, 9, 11 Provides 8-bit PWM output.

SPI 10 (SS), 11 (MOSI), 12
(MISO) and 13 (SCK)

Used for SPI communication.

Inbuilt LED 13 To turn on the inbuilt LED.

TWI A4 (SDA), A5 (SCA) Used for TWI communication.

AREF AREF To provide reference voltage for input voltage.
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Sign Language Table :

S4 S3 S2 S1 Output Voice command
0 0 0 0 Unity
0 0 0 1 Washroom
0 0 1 0 Tea
0 0 1 1 Help
0 1 0 0 Wait/Stop
0 1 0 1 Not well
0 1 1 0 Food
0 1 1 1 Peace
1 0 0 0 I
1 0 0 1 You
1 0 1 0 Lets go
1 0 1 1 OK
1 1 0 0 Thank you
1 1 0 1 Please
1 1 1 0 Call
1 1 1 1 Love

0 – Bend.
1 – Straight.
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Bluetooth Module(HC-05):

It is a master - slave module. In our glove, Bluetooth module is taking an

input from Arduino, then it is acting as a SLAVE unit and when Bluetooth module

is giving an input into the speaker or mobile phone, then it is acting as a MASTER

unit.

Fig. Bluetooth module HC-05.
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Hardware features

 Typical -80dBm sensitivity

 Up to +4dBm RF transmit power

 Low Power 1.8V Operation ,1.8 to 3.6V I/O

 PIO control

 UART interface with programmable baud rate

 With integrated antenna

 With edge connector

Software features

 Given a rising pulse in PIO0, device will be disconnected.

 Status instruction port PIO1: low-disconnected, high-connected

 Auto-connect to the last device on power as default.

 Permit pairing device to connect as default.

 Auto-pairing PINCODE:”0000” as default
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Output.

Here in this project we are going to demonstrate the output on smartphone

(with Bluetooth feature), as adding external speaker increases the price of the

gadget and external speaker requires power supply, so as we know in todays world

everyone has a smartphone or has a phone which has a bluetooth feature, so in

order to reduce the size of the project and reduce the cost we have replaced the

Bluetooth speaker with a smartphone.

Here the user don’t have to carry an external speaker everywhere, instead

only a glove is sufficient.
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Software Detail:

Here in this project we have used C language programming.

Following steps to be followed in order to in order to prepare the software.

Open Arduino IDE make sure that you have changed your signature as per targeted AVR

ATmega

1. Open Arduino IDE

2. File > Examples > Arduino ISP

3. Select Arduino328 from Tools > Board

4. Select your serial port .

5. Burn in your Arduino board.

6. Select Arduino as ISP from Tools > Programmer

7. Select Burn Bootloader

Upload the following code with Arduino UNO in our boot loaded chip (Atmega
328).

package com.example.texttospeech;

import android.support.v7.app.AppCompatActivity;

import android.os.Bundle;

import android.speech.tts.TextToSpeech;

import android.view.View;

import android.widget.Button;

import android.widget.EditText;

import java.util.Locale;

import android.widget.Toast;
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public class MainActivity extends AppCompatActivity

{ TextToSpeech t1;

EditText etInput;

Button btnRes;

@Override

protected void onCreate(Bundle savedInstanceState)

{ super.onCreate(savedInstanceState);

setContentView(R.layout.activity_main);

etInput=(EditText)findViewById(R.id.etInput);

btnRes=(Button)findViewById(R.id.btnRes);

t1=new TextToSpeech(getApplicationContext(), new

TextToSpeech.OnInitListener() {

@Override

public void onInit(int status) {

if(status != TextToSpeech.ERROR)

{ t1.setLanguage(Locale.UK);

}

}

});

btnRes.setOnClickListener(new View.OnClickListener()

{ @Override

public void onClick(View v) {

String input = etInput.getText().toString();

String output = ""; if(input.equals("0000"))
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output = "Unity";

else if(input.equals("0001"))

output = "Washroom";

else if(input.equals("0010"))

output = "Tea";

else if(input.equals("0011"))

output = "Help";

else if(input.equals("0100"))

output = "Wait or Stop";

else if(input.equals("0101"))

output = "Not Well";

else if(input.equals("0110"))

output = "Food";

else if(input.equals("0111"))

output = "Peace";

else if(input.equals("1000"))

output = "I";

else if(input.equals("1001"))

output = "You";

else if(input.equals("1010"))

output = "Let's go";

else if(input.equals("1011"))

output = "Ok";

else if(input.equals("1100"))

output = "Thank You";
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else if(input.equals("1101"))

output = "Please";

else if(input.equals("1110"))

output = "Call";

else if(input.equals("1111"))

output = "Love";

Toast.makeText(getApplicationContext(),

output,Toast.LENGTH_SHORT).show();

t1.speak(output, TextToSpeech.QUEUE_FLUSH, null);

}

});

}

public void onPause()

{ if (t1 != null) {

t1.stop();

t1.shutdown();

}

super.onPause();

}

}
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Chapter: 4
Conclusion and Discussion.
Here is some images of the project hardware.
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And here there are some images of c language programme we used.
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 Application:

The main application of this project is to provide aid for the speech-impaired
to communicate with those who do not know the sign language. Due to the
simplicity of the model, it can also be implemented in smartphones and is
regarded as our future plan to do so.

 Future Scope:

In future development of this project may include different languages, and
may be more portable size.
It may also include a gps tracker for the safety of the person,
It may include the whole conversation as here we have only added the basic
gestures which are needed in case of emergency such as drinking, washroom
and some more gestures.
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Chapter: 5

Achievements.
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